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1 Présentation

1.1 Télécharger Texmacs 1.6

1. Aller sur le site http://www.texmacs.org

2. Download → Windows

3. Dans Notes, télécharger Miktex et l’installer en premier !!

4. Dans Installation of Texmacs, télécharger CygTeXmacs.zip

5. Le copier directement sur le disque dur dans un répertoire de C:\
(Le nom de ce répertoire ne doit pas comporter d’espace.)

6. Décompresser CygTeXmacs.zip dans ce répertoire.

7. Pour lancer TeXmacs, lancer starttexmacs.bat

1.2 Le logiciel Texmacs

Il s’agit d’un éditeur de texte scientifique qui vous permet d’écrire des documents structurés « tel écran,
tel écrit» (impression conforme à la visualisation) et de bénéficier d’une interface utilisateur agréable. De
nouveaux styles peuvent être créés par l’utilisateur. Le programme implémente des algorithmiques typogra-
phiques complexes et des polices TEX, ce qui permet de produire des documents de qualité professionnelle.

Ses hautes performances typographiques vont jusqu’à la génération automatique de formules, ce qui fait
de TEXMACS une interface idéale pour les logiciels de calcul formel. TEXMACS reconnaît aussi le langage
d’extension Guile/Scheme, ce qui autorise l’utilisateur à personnaliser l’interface et à écrire ses propres
extensions d’édition.

Il est prévu de faire évoluer TEXMACS vers une suite de bureau scientifique complète, avec
tableur, éditeur de dessin industriel et mode présentation.

Un des objectifs majeurs de TEXMACS est de promouvoir le développement de logiciels libres par et pour
les scientifiques, en réduisant considérablement le coût de production d’interfaces utilisateur de haute qualité.
Si vous souhaitez écrire une interface entre TEXMACS et un autre logiciel, n’hésitez pas à contacter l’équipe

contact@texmacs.org

2 Création de documents

2.1 L’interface Texmacs

La barre de menus� Donne l’accès à toutes les fonctionnalités Texmacs.

Création de documents 5
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Les barres d’outils� Ensemble de raccourcis des menus les plus utilisés.

La barre d’états a deux rôles bien spécifiques:

1. Rappel des propriétés du document:

A gauche, elle permet de vérifier les propriétés du document: style, mode (texte ou mathématique),
format de la police.

A droite, elle indique la nature de l’environnement courant où se situe le curseur.

2. Boîte de dialogue avec l’utilisateur:
Par exemple vous souhaitez insérer un espace horizontal fixe pour décaler du texte – fonctionnalité

accessible depuis le menu Insérer – Texmacs vous demande alors (en bas à gauche) de préciser la lar-
geur de cet espace en utilisant la barre d’état comme boîte de dialogue:

Vous renseignez la dimension souhaitée en n’omettant pas de préciser les unités !! :

Conseil: A la suite d’une manipulation l’interface de Texmacs vous semble inactive, vérifiez que
vous n’avez pas, par erreur, ouvert une boîte de dialogue. En effet, tant que vous ne renseignez pas

Texmacs, il attend...Pour annuler une boîte de dialogue, il suffit d’appuyer sur Echap .

2.2 Débuter un document Texmacs

Choix d’une langue Editer→Préférences→Langue→Français

Nouveau document Fichier→Nouveau

Sauvegarder sous Fichier→ Sauvegarder sous

Vous accédez à l’arborescence de vos fichiers (vous pouvez y naviguer en cliquant sur Racine en bas à

gauche), sélectionnez le répertoire danslequel vous souhaitez enregistrer votre fichier et donnez-lui un nom.
Un document Texmacs doit être enregistré en: .tm .

Par exemple, ici, le document est enregistré dans le répertoire STAGE, sous le nom de Essai.tm

6 Section 2
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Il est conseillé de Sauvegarder Sous un document dès sa création pour éviter de le perdre.

Notons que Texmacs effectue une sauvegarde automatique des documents ouverts toutes les 120s par
défaut, vous pouvez modifier (ou désactiver) ce laps de temps en allant à:

Editer→Préférences→ Sauvegarde Automatique

Ouvrir un document Fichier→Charger...

Vous accédez à l’arborescence de vos fichiers, à vous d’y rechercher le document souhaité.

Choix d’un style
Document→ Style

Texmacs vous propose de créer plusieurs types de documents Article, Livre, Séminaire (pour la présenta-
tion), Examen, Lettre.

Chacun de ces styles correspond à un environnement bien spécifique et prédéfinit la mise en forme de
votre document : Page de couverture, marges, police, structures internes (section ou chapitre...)

C’est une facilité offerte par Texmacs; si les paramètres créés par défaut ne vous conviennent pas, vous
pouvez les modifier manuellement voire même personnaliser votre interface et créer votre propre style.

L’environnement mathématique proposé pour chaque style

− Pour tous les styles sauf Examen, vous aurez accès aux environnements suivants:

− Pour le style Examen, il n’y aura que les environnements Exercice et Problème.

Choix du papier et orientation de la page : Paysage ou Portrait

Création de documents 7
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Document→Page → Taille

Vous pouvez choisir le format de votre document Texmacs A4, A3, Lettre...

Document→Page → Orientation→Portrait ou Paysage

Naviguer entre les différents documents Texmacs ouverts Grâce au menu Aller .

Aide Le menu Aide permet d’avoir accès au manuel d’utilisation, à une aide en ligne, à de la recherche de

termes spécifiques.

2.3 Généralités sur la saisie de texte

Sélection de police
Format→Nom

Balises de contenu
Texte→Balise

Texmacs génère un typographie automatique suivant la nature du mot que vous souhaitez utiliser.

Par exemple, si vous souhaitez écrire du texte important, par défaut il sera mis en gras et vous y avez
accès depuis la barre d’outil avec l’item S ; mais si vous définissez (lorsque vous saurez personnaliser Tex-

macs) que le texte important doit être souligné, en cliquant sur S , Texmacs produira du texte souligné.

Balises de présentation
Texte→Balise de présentation

Ces balises permettent de Souligner, Surligner, Mettre en indice ou
en exposant du texte.

Listes et énumération
Elles sont accessibles directement depuis la barre d’outils.
Elles n’apparaîtront pas dans la table des matières.
Elles génèrent un sous-environnement qui leur est propre, tant que vous souhaitez énumérer ou lister, ne

sortez pas de cet environnement.

1. Texte→Liste

Vous pouvez choisir un marqueur particulier pour chaque élément de la liste : • (puces), − (tirets) or →
(flèches) ou utiliser le marqueur par défaut. Les listes peuvent être imbriquées comme ci-dessous :

• Premier élément.

• Sous-liste :

◦ Sous-élément.

◦ Autre sous-élément.

• Dernier élément.

Le marqueur par défaut change suivant le niveau d’imbrication. Au niveau le plus haut, on utilise •, au
niveau secondaire ◦, et ainsi de suite.

Quand le curseur se trouve à l’intérieur d’une liste et que vous appuyez sur Entrée , un nouvel élément
est automatiquement ajouté à la liste.

Si la longueur de certains éléments dépasse la longueur de la ligne, appuyez sur Alt-Entrée pour aller à
la ligne sans sortir de l’élément.
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2. Texte→Enumération

Leurs éléments sont numérotés. Voici une énumération obtenue avec

Texte→Enumération→ I,II,III

I. Premier élément.

II. Second élément.

III. Dernier élément.

3. Texte→Description

Le dernier type de liste sert à faire une description, cela permet de définir une liste de choses :

Suite croissante. La suite (un)n∈N est dite croissante si pour tout entier n, un 6un+1.

Suite décroissante. La suite (un)n∈N est dite décroissante si pour tout entier n, un > un+1.

Outils d’édition
Outre les outils d’édition traditionnels, texmacs propose un correcteur orthographique.

Par ailleurs, dans Editer→Préférences vous pouvez configurer l’aspect de votre interface, le clavier,

l’imprimante, et le délai de sauvegarde automatique.

Saut de ligne et saut de page
Insérer→ Saut

Note de bas de page

Insérer→ Insetion de page→Note de bas de page 1

Gérer les paragraphes du document

Document→Paragraphe

Pour régler les paramètres des paragraphes de TOUT le document.

Format→Alignement (Marges, Espacement, Césure, Nb de colonnes)

Pour régler les paramètres d’un paragraphe particulier.

Aller à la ligne sans retrait

Shift-Entrée

2.4 Environnements

Environnements imbriqués

La structure d’un document Texmacs repose sur l’imbrication d’environnements différents, ils traduisent
l’arborescence Latex sous-jacente.

Par exemple :

1. Ceci est une note de bas de page.

Création de documents 9
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(Listes)

1. (Listes)

• (Insertion balise mathématique)

Remarque 1. La formule est (Insertion Mode Math.)
∫

2

+∞
f(t)dt =π

Attention de ne pas abuser des imbrications d’environnement, la situation deviendrait vite inextri-
cable. Lorsque l’on vient d’insérer du texte en mode mathématique et que l’on souhaite rebasculer en Math,
l’erreur courante consiste à vouloir ré-insérer un mode Math au lieu de tout simplement sortir du mode Texte
courant.

La barre d’état permet de rester vigilant quant au niveau d’imbrication des environnements.

L’apparence des environnements: curseur et cadres de couleurs

Curseur rouge. Mode texte

Curseur incliné violet. Mode mathématique

Cadre turquoise. Délimite l’environnement courant. (Mathématiques, listes, tableaux....)
Une imbrication d’environnement se traduira par une imbrication de cadres.

Cadre rouge. Sélection courante (permet de copier, coller, suprimer, modifier police.....)

Pour annuler un cadre de sélection, il est conseillé de placer le curseur quelque part sur la page
et d’appuyer sur la barre d’espace. (Supprimez par la suite l’espace inséré...)

Si vous avez sélectionné un contenu, à chaque double-clic que vous effecturez, vous sélectionnerez
l’environnement supérieur, et ainsi de suite jusqu’à sélectionner le document entier.

Si par mégarde vous effacez du contenu, annulez votre manipulation dans

Editer→Annuler

Cadre violet. Sélection de cellules dans un tableau, permet la mise en page de ces cellules.

Le rappel des environnements: le rôle de la barre d’état

A gauche, elle permet de vérifier les propriétés du document: style, mode (texte ou mathématique),
format de la police.

A droite, elle indique la nature de l’environnement courant où se situe le curseur.

Entrer et Sortir d’un environnement

Entrer et Sortir du mode Mathématique.

La touche $ est une bascule qui permet d’entrer ou sortir de ce mode.

Insérer du texte en mode mathématique.
Par la combinaison Alt-$ ou bien Insérer→Mathématiques →Texte

Insérer tout autre type d’environnement.
Le choisir dans la barre des menus. ( Listes, tableaux, théorèmes...)

Sortir d’un environnement.
Déplacer le curseur à l’extrémité droite de son cadre grâce à la touche → .

Pour revenir dans l’environnement précédent, déplacer le curseur vers la gauche à l’aide de la
touche ← .
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Pour le cas de l’environnement Liste, tant que votre énumération n’est pas finie, ne sortez pas de
son environnement, vous ne pourriez plus la continuer...

3 Formules mathématiques

3.1 Les caractéristiques du mode Mathématique

Le mode mathématique permet d’accéder à l’ensemble des outils mathématiques que propose Texmacs.
On y accède par deux types d’environnements, que vous pouvez choisir directement depuis la barre d’outil

grâce à l’item :

− L’environnement Formule

− Les environnements Equation

L’entrée dans ce mode génére un nouveau menu Mathématique qui remplace le menu Texte.

Dans la barre d’outils, vous avez accès désormais à:

Environnement Formule

La touche $ est une bascule qui permet d’entrer ou sortir de ce mode.

Exemple de formule qui s’intègrent dans le texte: sin2 x + cos2x =1 .

3.2 Principaux objets mathématiques

• Les principaux objets mathématiques sont créés avec le préfixe Alt- , comme suit :

Raccourcis Objets Exemples
Alt-$ Texte L = {x|x est assez grand}
Alt-f Fractions

a

b + c

Alt-s Racines carrées x+ y
√

Alt-S Racines nièmes x3 + y33
√

Alt-n Négations
a

b + c

Tableau 1. Raccourcis mathématiques principaux

Pour la négation, sélectionner d’abord l’objet puis le barrer.

Les symboles prime, prime à gauche, exposants et indices sont crées de la façon suivante:

Raccourcis Objets Exemples
’ Symbole prime f ′ ou (f + g)′′′

‘ Symbole prime gauche f8

_ Indices xn ou xi3

^ Exposants x2, xn
2 , ou ee

x

Alt-1 _ Indices à gauche x2
Alt-1 ^ Exposants à gauche xπ ou He∗

∗
∗
∗

Tableau 2. Création de symboles primes, indices et exposants

• Grands opérateurs: Accessibles directement depuis la barre d’outils ou par le clavier:
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Raccourcis Résultat Raccourcis Résultat

Shift-F5 I
∫

Shift-F5 O
∮

Shift-F5 P
∏

Shift-F5 A
∐

Shift-F5 S
∑

Shift-F5 @ +
⊕

Shift-F5 @ x
⊗

Shift-F5 @ .
⊙

Shift-F5 U
⋃

Shift-F5 N
⋂

Shift-F5 V
∨

Shift-F5 W
∧

Tableau 3. Grands opérateurs mathématiques

Les intégrales admettent deux formes selon la place des indices et exposants. Par défaut, les expo-
sants et indices sont placés comme ci-dessous :

∫

0

∞ dx

1 +x2

Pour obtenir la variante «avec limites» :
∫

0

∞

dx

1+ x2

→ Soit utiliser Shift-F5 L I et de même Shift-F5 L 0 pour obtenir la variante
∮

avec limites.

→ Soit Sélectionner le signe courant
∫

puis Alt-a pour la limite supérieure et Alt-b pour la
limite inférieure.

• Petits opérateurs: Accessible depuis la barre d’outils par la touche ⊗ ou par le clavier:

Raccourcis Résultat

Shift-F5 a ⊔
Shift-F5 n ∩
Shift-F5 v ∨
Shift-F5 u ∪
Shift-F5 W ∧

Tableau 4. Petits opérateurs mathématiques

• Les grands délimitateurs s’adaptent à la taille du contenu :

Ainsi on a

(

1

2

)

au lieu de (
1

2
) avec des parenthèses classiques.

Accessibilité: Directement dans la barre d’outils ou par le clavier:

Raccourcis Résultats Raccourcis Résultats

Alt-( ( Alt-) )
Alt-[ [ Alt-] ]
Alt-{ { Alt-} }
Alt-< 〈 Alt-> 〉
Alt-/ / Alt-\ \

Tableau 5. Grands délimiteurs

• Larges accents mathématiques: Accessibles dans le menu par:

Mathématiques→Accent en haut et Mathématiques→Accent en bas

ou directement depuis la barre d’outils

ou par le clavier:
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Raccourcis Exemples Variantes larges

Alt-V uK AB
Alt-B x̄ x + y

Alt-~ x̃ x + y

Alt-C x̌ x + y

x̂ x + y

Alt-U x̆ x + y

Tableau 6. Accents mathématiques

• Où trouver d’autres signes très courants dans la barre d’outils ?:

Barre d’outils Signes accessibles
⊗ ± ,× ,÷ , ∗�
≺ ∼ ,≃ ,≡ , 6 ,⊂ ,∈�
℘ d, i , ı, ℓ, ∅,⊤,⊥ , ∀, ∂ ,∞, ∃

3.3 Les polices spécifiques

Le mode mathématique permet d’avoir accès à des polices spécifiques:

− L’alphabet Grec : α Exemples: α, β, π�
Clavier: F5 →Lettre romaine équivalente

− Une police grasse pour tous les caractères spécifiques : B

Clavier: F6 →Lettre romaine équivalente

− Une police calligraphique: C Exemples: A,D, E�
Clavier: F7 →Lettre romaine équivalente

− L’alphabet gothique: F Exemples: i, R, I�
Clavier: F8 →Lettre romaine équivalente

− L’alphabet onciale: B Exemples: C,N,Q,R�
Clavier: Shift-F8 →Lettre romaine équivalente

3.4 Les équations

Les équations sont un environnement mathématique à part entière, vous ne pouvez donc pas le créer si vous
êtes déjà en mode mathématique.

Equation simple Insérer→Mathématiques→Equation

∫

1

5
∑

n=1

+∞(

un
2 − ax

un

√
)

dx= 3a, ∀a∈R

Equations multiples Insérer→Mathématiques→Equations Alt-&

Les équations multiples ont une structure de tableau à 3 colonnes qui permet un alignement parfait terme
à terme lors de calculs successifs. Lorsque vous générez un environnement équations multiples, apparaît à
droite dans la barre d’état:
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Par l’indication ”(1,2)”, Texmacs vous indique que votre curseur se situe à la première ligne de la
deuxième colonne de votre tableau.

Pour aligner vos équations, il suffit par exemple de mettre les premiers termes de votre équation en pre-
mière colonne, les ”= ” en deuxième colonne, et les deuxièmes termes en troisième colonne:

(x− 3)(2x+ 1) = 4(2x+ 1) (1)

(x− 3)(2x + 1)− 4(2x+ 1) = 0 (2)

(2x+ 1)(x− 7) = 0 (3)

Vous pourrez par la suite agencer le contenu de ce tableau comme bon vous semble (alignement, positionne-
ment à droite ou à gauche des termes) en vous référant aux méthodes de mise en page des tableaux expli-
quées au chapitre suivant.

Numéroter les équations A la suite de l’équation:

Mathématiques→Numéroter l’équation Alt-*

Pour retirer le numéro, toujours à la suite de l’équation:

Mathématiques→Enlever le numéro Alt-*

Insérer du texte en mode mathématique

Bien que l’on puisse y taper du texte, le mode mathématique ne reconnaît pas toutes les typographies du
mode texte en particuliers les accents. Les caractères non reconnus sont alors rouges.

Il est donc parfois utile de pouvoir insérer du texte :

Insérer→Mathématiques→Texte Alt-$

3.5 Arbres et tableaux spécifiques : Matrice, déterminant, et système

1. Arbres

Arbre. $ →Mathématique→Arbre

ModeMathématique

Tableau

Matrice�Déterminant� Système

2. Matrices, déteminants et systèmes

Les objets suivants font partie de l’environnement Tableau. Vous y avez accès depuis la barre

d’outils par l’item en mode mathématique.

Une fois sélectionnés de nouveaux items apparaissent dans la barre d’outils:

qui permettent de modifier et d’opérer sur ces objets. (Pour plus de détails, se référer au chapitre
suivant consacré aux tableaux.)

Matrice. $ → Insérer→Tableau→Matrice

M =





2 3 − 7
− 11 0 1

0 1 4




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Déterminant. $ → Insérer→Tableau→Déterminant

detA=

∣

∣

∣

∣

2 3
− 1 7

∣

∣

∣

∣

Système. $ → Insérer→Tableau→Choix

(S):

{

2x− 3y = 4
x+ y = 2

Important :

→ Pour ajouter des lignes : Entrée ou

→ Pour ajouter des colonnes : Alt - → ou

4 Tableaux

4.1 Création de tableaux

Petits et grands tableaux Insérer→Tableau→Petit Tableau (ou Grand Tableau)
ou

→ Petit Tableau (ou Grand Tableau)

Ce sont des tableaux numérotés dont on peut renseigner une légende.
D’autre part, Texmacs pourra fournir une liste des tableaux créés sur tout le document.

Bloc standard et bloc centré Insérer→Tableau→Bloc standard (ouBloc centré)
ou

→Bloc standard (ouBloc centré)

Ce sont des tableaux unicellulaires avec bordures apparentes qui servent généralement pour encadrer du
contenu.

Bloc standard. L’alignement horizontal du contenu sera par défaut à gauche.

Bloc centré. L’alignement horizontal du contenu sera par défaut centré.

Tableau standard et tableau centré Insérer→Tableau→Tableau standard (ouTableau centré)
ou

→ Tableau standard (ouTableau centré)

Ce sont des tableaux qui par défaut sont créés unicellulaires avec bordures invisibles.

Tableau standard. L’alignement horizontal du contenu sera par défaut à gauche.

Tableau centré. L’alignement horizontal du contenu sera par défaut centré.
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4.2 La mise en page des tableaux

La création de ces tableaux génère l’ouverture d’un environnement spécifique qui se traduit par l’appari-
tion de nouveaux items dans la barre d’outils:

et de deux nouveaux menus Tableau et Cellules.

Deux types d’opérations sont possibles:

− Sur le tableau entier

Insérer ou supprimer des colonnes ou lignes.

Permet de préciser la taille du tableau.

Permet de modifier le contour extérieur du tableau.

Positionner le tableau sur la page. Permet de mettre au même niveau des tableaux qui sont
côte à côte.

Propriétés spéciales du tableau: Limitation de taille, césure...

− Sur les cellules ou groupement de cellules

Change le mode d’opération. permet d’opérer sur des groupements particuliers de cellules.

Modifie les alignements horizontaux et verticaux du contenu de la cellule.

Permet de régler la taille des cellules: hauteur, largeur...

Texmacs ouvre alors une boîte de dialogue dans la barre d’état et vous demande de préciser, en cm
ou mm, la hauteur ou la largeur souhaitée.

Par exemple, pour la construction du tableau de variation la hauteur de la deuxième ligne a été
modifiée en sélectionnant Hauteur Exact, une boîte de dialogue s’ouvre:

Ne pas oublier de spécifier les unités (cm , mm ...) !!

Permet de gérer la bordure d’une sélection de cellules.
Texmacs ouvre alors une boîte de dialogue dans la barre d’état et vous demande de préciser, en cm
ou mm, l’épaisseur du trait.

A titre d’indication, tous les tableaux du guide sont construit avec une bordure de 0.1mm.

Pemet de modifier la hauteur de texte, la césure des cellules...
Modifier la césure permet par exemple de réaliser une hierarchie de section au sein même de la cel-
lule ou de pouvoir insérer des images.

4.3 Les tableaux de variation

Il n’y pas actuellement de macros spécifiques pour les tableaux de variations.
Il faut donc «bricoler» un tableau standard en manipulant judicieusement les ajouts de cellules, leur lar-

geur, leur bordure ou non, et l’alignement des contenus.
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Exemple:
x −∞ 0 +∞

f

2

ր +∞ +∞ց
−∞

Ce tableau contient 8 colonnes de largeurs différentes et deux lignes de hauteurs différentes.
Les alignements horizontaux et verticaux des contenus varient suivant les besoins.
Les bordures ne sont apparentes qu’aux endroits précis où elles sont nécéssaires.

5 Graphiques

La nouvelle version 1.6 de Texmacs intègre la création de graphique au sein même de l’interface.
En effet Texmacs propose deux alternatives:

− Un mode Graphique: Insérer→ Image → Dessiner Image

Il génère une interface graphique avec outils de dessin, feuille millimétrée..., il met à disposition
quantités d’environnements graphiques auxquels on accède par le nouveau menu Graphics.

Une nouvelle barre d’outil apparaît:

Ce mode permet entre autres:

• d’insérer un graphique en coordonnées cartésiennes, polaires et semi-logarithmiques. Le fond du
graphique étant constitué de papier millimétré par défaut. On peut modifier à loisir le type de
papier support, modifier les espacements...

On peut aussi régler la taille du graphique.

• Sur ce graphique, Texmacs met à disposition des outils de dessin qui permettent par exemple
de dessiner des vecteurs, lignes courbes, ou polygones.
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− Un outil de représentation graphique: Insérer→ Image → Graphique

Texmacs permet d’insérer des courbes et des surfaces par l’intermédiare d’une boîte de dialogue qui
permet de définir les paramètres des fonctions.

Par exemple: Pour tracer la courbe représentative de f :
[− 4; 7] � R

x 	 x2

Insérer→ Image → Graphique → Courbe

Apparaît alors la fenêtre Plot curve que l’on complète :

Plot curveFonction
f : x2Partie
x: − 4 – 7

Après validation( Entrée ), elle est alors représentée sur fond blanc.

 0

 5

 10

 15

 20

 25

 30

 35

 40

 45

 50

-4 -2  0  2  4  6

x**2

Bien que cette partie Graphics soit encore en construction et donc pas très stable, elle reste tout à fait
exploitable.

6 Liens et génération automatique de contenu

6.1 Création d’étiquettes, de liens et de références

Au cours de la rédaction d’un document, on peut souhaiter se référer à un chapitre (ou à un théorème,
une définition, une équation etc...).

On pourrait écrire tout simplement « .....voir détails au chapitre 6 », par exemple.
Mais, imaginons que par la suite, on veuille insérer un autre chapitre avant celui-ci, Texmacs rebaptisera

alors automatiquement mon ancien chapitre 6, en nouveau chapitre 7.
Il faudra donc, relire tout le document pour changer les anciennes références au chapitre 6, en nouvelles

références au chapitre 7.
Texmacs propose une solution en offrant la possibilité de créer des étiquettes et références automatiques,

qui s’adaptent aux modification apportées en cours de rédaction.
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Le principe est le suivant:

− On étiquette l’objet auquel on souhaite par la suite se référer, c’est à dire on lui attache un mot-clé
(ou identifiant) indépendant de sa numérotation automatique.

− A l’endroit où l’on souhaite le citer, on crée une référence en y précisant le mot-clé qui a servi à éti-
queter notre objet.

Ces étiquettes et références sont accessibles immédiatement depuis la barre d’outils, comme exposés ci-
dessous.

Exemple. Vous souhaitez invoquer le théorème des valeurs intermédiaires, que vous avez exposé préce-
demment, il vous faudra :

1. Placer une étiquette fixe (dénomination indépendante du numéro du théorème) au niveau du
théorème.

Insérer→Lien→Etiquette

→ Apparaît l’instruction 〈label|〉
→ Placez votre mot-clé qui servira d’identifiant au théorème

〈label|ThmValeursIntermediaires〉
→Validez l’étiquette en appuyant sur Entrée

2. Placer le curseur là où vous souhaitez invoquer le théorème, puis insérer une référence à l’éti-
quette voulue:

Insérer→Lien→Référence

→ Apparaît la fonction 〈reference|〉
→ Indiquez l’étiquette àlaquelle vous souhaitez vous référer

〈reference|ThmValeursIntermediaires〉
→Validez la référence en appuyant sur Entrée

De cette façon, quelques soient les modifications ultérieures de votre document, si le numéro de votre
théorème change, la référence changera aussi.

Il est vivement conseillé de mettre une étiquette indépendante du numéro généré automatiquement
par Texmacs, car celui-ci est susceptible d’évoluer au gré de votre rédaction. On préférera un mot-clé l’identi-
fiant facilement.La position de l'étiquette change suivant l'environnement auquel on souhaite seréférer, des exemples sont donnés ci-après.
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Application 1. Se référer à un environnement type Section/Chapitre

Placer le curseur juste après le nom de la section, puis insérer une étiquette.

− Insérer l’étiquette après le titre de la section:

6 Liens et génération automatique de contenu〈label|SectionLiensAutomatique〉
→ Valider

− Insérer la référence dans le document:

[...] d’après la section 〈reference|SectionLiensAutomatique〉
→ Valider

− On obtient:
[...] d’après la section 6

Application 2. Se référer à un environnement Théorème

Placer l’étiquette indifféremment avant ou après le contenu du théorème.

Théorème 2. 〈label |ThmValeursIntermediaires〉Le nom de l’étiquette doit toujours être indépendant du
numéro du théorème référant.

D’après le théorème 〈reference|ThmValeursIntermediaires〉, ....

Remarque: D’autre part, si on a inséré une référence au lemme (2.2), il suffit de cliquer sur (2.2) pour
voir le texte du lemme apparaître à l’écran.

Application 3. Se référer à une Equation

Toujours placer l’étiquette avant l’équation.

Ceci vous permet de vous référer au numéro d’une équation que vous aurez au préalable numérotée.

Insertion d’hyperlien Insérer→Lien→Hyperlien

Permet d’insérer des adresses internet actives.

En cas de non affichage des références, pensez à réactualiser votre document :

Document→Actualiser → le tout

6.2 Insertion d’image

Les formats reconnus
La majorité des formats sont reconnus: png, fig, gif, eps, jpg pdf, ppm...

Figure ou image ? Insérer→ Image→Petite figure (ou Grande figure)

ou Insérer→ Image→ Insérer Image

Les figures vont pouvoir être légendées et Texmacs pourra proposer une liste des figures insérées dans
l’intégralité du document, les images non.

Lier ou insérer ? Insérer→ Image→Lier Image
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ou Insérer→ Image→ Insérer Image

Si vous liez une image par exemple Escher.png, et que par la suite vous changez le nom de l’image source,
ou vous la détruisez Texmacs ne la trouvera plus et l’image n’apparaîtra plus dans votre fichier. Si vous con-
servez le nom mais que vous changez l’image, l’image changera aussi dans votre fichier texmacs.

Si vous insérez l’image, elle restera dans votre ficher contre vents et marées...

Régler la taille d’une image

Après avoir inséré l’image, placez le curseur à son extrémité (le curseur doit prendre la hauteur de votre

image) et appuyez sur ← , vous obtenez le cadre suivant

〈postscript|〈tuple|〈raw-data〉|jpg〉|*6/8|*5/8||||〉

Le 6/8 de gauche vous indique le coefficient de réduction de sa largeur.
Le 5/8 de droite vous indique le coefficient de réduction de sa hauteur.

A vous de les modifier suivant vos besoins, par exemple

〈postscript|〈tuple|〈raw-data〉|jpg〉|*3/8|*3/8||||〉

puis vous appuyez sur Entrée pour constater les effets.

6.3 En-tête et bas de page

Insérer→En tête et bas de page

Vous avez alors la possibilité de créer des En tête et bas de page, présents uniquement sur la page cou-
rante, de façon permanente, pour les pages paires ou impaires.

6.4 Génération automatique de contenu

6.4.1 Génération automatique de Table des Matières

Texte→Automatique → Table des Matières
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Vous pouvez la positionner aussi bien en début ou en fin de document .
Une fois créée, pour la générer entièrement il faut actualiser le document:

Document→Actualiser → le tout
ou

Document→Actualiser → Table des matières

Ne pas oublier de réactualiser son document avant l’impression sinon la table des
matières ne sera pas à jour. Parfois, il est conseillé de fermer le document puis de le réouvrir pour que
l’actualisation soit efficace et rapide.

La table des matières est active, si on clique sur le numéro de page qui correspond à une entrée dans
cette table, le curseur et l’écran visible vont se positionner sur le début du texte correspondant.

6.4.2 Liste de figures et de tableaux

Texte→Automatique → Liste de tableaux
ou

Texte→Automatique → Liste de figures

Texmacs vous permet de générer la liste des figures ou tableaux légendés utilisées sur tout le document.

7 Impression d’un document

Actualiser un document
Document→Actualiser → le tout

Vue
Document→Vue → Mise en page→Marges comme sur le papier

vous permet de visualiser à l’intérieur de l’interface le document tel qu’il sera à l’impression.

Marges du document
Document→Page → Marges
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Vous pouvez changer les marges à gauche, à droite, en bas et en haut en renseignant dans la boîte de dia-
logue de la barre d’état l’espacement souhaité. (Ne pas oublier les unités !)

Saut de page
Insérer→ Saut→ Nouvelle page

Format d’export de documents: pdf, ps, Html....

Fichier→Exporter

Prévisualisation

1. Choisir le logiciel de prévisualisation (Généralement Acrobat Reader....)

Fichier → Paramètres d’impression → Commande de Prévisualisation → Acrobat Reader

2. Prévisualiser le document:
Fichier→ Imprimer→ Prévisualier avec Acrobat Reader

Impression
Fichier→ Imprimer→ Le tout
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